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Introduction
Cisco TelePresence Management Suite Extension for Microsoft Exchange (Cisco TMSXE) is an optional 
add-on to the Cisco TelePresence Management Suite (Cisco TMS) that allows you to fully integrate the 
scheduling functionality of Cisco TMS with your existing Microsoft Exchange deployment. This integration 
gives users the ability to schedule videoconferences and invite participants directly from their Microsoft 
Outlook clients while viewing availability information of resources regardless of where meetings are created.

This installation guide takes you through the entire process of installation and initial configuration, and 
provides an overview of requirements and prerequisites that should be reviewed before installing. We 
strongly recommend adhering to the Deployment best practices [p.11] described in this document.

For a software reference and functional overview for administrators and troubleshooting tips, refer to the 
Cisco TelePresence Management Suite Extension for Microsoft Exchange Administrator Guide.

Upgrade recommended

The 2.x version branch of this product is no longer being maintained by Cisco. We strongly recommend that 
customers migrate to  Cisco TMSXE 3.0 or later, which supports Microsoft Exchange 2007 and 2010. For 
migration guidance, see  Cisco TelePresence Management Suite Extension for Microsoft Exchange 
Installation Guide (3.0).

Limited Cisco TMS support

Note that only certain versions of Cisco TMS support Cisco TMSXE 2.x. For details, see the Cisco TMS 
requirements [p.6].

End user guidance
We recommend that administrators supply their users with a link to the Cisco TelePresence Management 
Suite Extension for Microsoft Exchange User Guide (2.3). It is also important that users be made aware 
which Exchange version (and subsequently which booking model) applies to them.
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Server requirements
The requirements assume you are installing on an operational Exchange server and that all Microsoft 
requirements for the Exchange server are satisfied.

Exchange 2003
Product Version/service 

pack (SP)
Additional requirements and recommendations

Microsoft Exchange Server 
2003

SP 2  n Standard or Enterprise Editions.
 n Exchange System Manager must be installed on the server.

Microsoft Windows Server 
2003 R2 32-bit 

SP 2 Domain functional level [p.5] Windows 2000 native mode or 
higher recommended, see below.

Microsoft .NET Framework 2.0 SP 2 or later

 

 

Exchange 2007
Product Version/service 

pack (SP)
Additional requirements and recommendations

Microsoft Exchange Server 2007 SP 3  n Standard or Enterprise Editions.
 n The server must have the Mailbox Server role 

installed.

Microsoft Windows Server 2003 R2 64-
bit (Recommended, see note below)

SP 2 Domain functional level [p.5] Windows 2000 
native mode or higher recommended, see below.

Windows Server 2008 R1 64-bit SP 2 See note below for caveats.

Microsoft .NET Framework 2.0 SP 2 or 
later

 

 

Note: Several reports have been made of high server load causing Cisco TMSXE to stop functioning when 
using Windows Server 2008 with Exchange 2007 in large deployments. When the configuration tool is 
opened, the error message "The interface is unknown" is displayed, and the service will resume only after 
restarting the Exchange Information Store. The problem is caused by the use of CDOEX technology  that has 
been de-emphasized by Microsoft. For new Cisco TMSXE deployments, using Windows Server 2003 R2 is 
therefore recommended. Cisco is committed to resolving this issue in a future release for the Windows 
Server 2008 environment.

Domain functional level
The Active Directory domain functional level  must be Windows 2000 native mode or higher in order to support 
the group permissions used on the calendars for Exchange 2003. Windows 2000 mixed mode does not 
support these group permissions.
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If opting to keep mixed mode for the domain functional level, the two default security groups will not be 
created by the installer, and you must apply your own set of permissions on the resource calendars as 
described in Defining calendar security groups [p.15].

Exchange licensing
Installing Cisco TMSXE has no impact on your Microsoft Exchange licenses.

The user accounts and mailboxes created to represent Cisco TMS systems do not require or consume Client 
Access Licenses (CAL) for your Exchange server. CAL licenses are tied to users or devices accessing the 
server, not the mailboxes themselves. An installation of Cisco TMSXE only needs one CAL for the server's 
components themselves.

Client requirements
Product Requirements

Microsoft Outlook 2007 
Service Pack 2

Note that Service Pack requirement is absolute; Service Pack 1 has known 
issues with Cisco TMSXE.

Microsoft Outlook Web Access 
(OWA)

 n Only supported with Exchange 2007.
 n The  custom videoconference booking form is not available when using OWA.

Cisco TMS requirements
Version 13.0.2, 13.1, 13.1.1, or 13.2.2

Network  n HTTP (HTTPS optional) connectivity is required from the Exchange Server to Cisco TMS.
 n Cisco TMS must be able to send email to the Exchange Server's domain.

Licensing Either:                     
 n One Cisco TelePresence Management Suite Extension for Microsoft Exchange option key per 25 

endpoints integrated with Cisco TMS, usually recommended for smaller deployments. See below 
for detail on how system licenses are activated.

 n One Application Integration Package option key per Exchange Server integrated with Cisco TMS, 
recommended for deployments with a large number of systems to be integrated.

Enabling option keys
To enable an option key in Cisco TMS:

 1. Go to Administrative Tools > General Settings.
 2. In the Licenses and Option Keys pane, click Add Option Key.
 3. Input the option key string.
 4. Click Save.

Per system licensing
Note that each system to be integrated with Exchange must already have been added to and licensed for use 
with Cisco TMS.
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Once the Exchange Integration Option has been activated in Cisco TMS, the Allow Remote Bookings 
setting determines whether each system is using a license.

The first time Exchange booking is used for a system, Allow Remote Bookings will be toggled to Yes for 
that system in Cisco TMS, provided a license is available. If no more licenses are available, Allow Remote 
Bookings will still be set to No for that system, and the requested booking will be denied. A Cisco TMS 
ticket will be generated to notify the administrator that no more licenses are available.

To view and/or manually modify the setting:

 1. In Cisco TMS, go to Systems > Navigator.
 2. Select the system you want.
 3. Click the Settings tab.
 4. In the      TMS Scheduling Settings pane, you will find Allow Remote Bookings set to Yes or No. 
 5. If you want to modify the setting, click Edit Settings.
 6. Use the checkbox to toggle the setting.
 7. Click Save.

Note: The Allow Remote Bookings setting is only visible if one or more Microsoft Exchange Option keys 
have been activated in Cisco TMS. If an Application Integration Package option is also activated, the setting 
will be void and therefore hidden.

Email settings limitation
Cisco TMSXE 2.3 and 2.3.1 do not support HTML email. If Cisco TMS is set up to send HTML email, 
message bodies will be displayed as blank. To ensure your email setting is compatible:

 1. Go to Administrative Tools > Configuration > Email Settings.
 2. Make sure E-mail Content Type is set to either Both (Multipart) or Plain Text.
 3. Click Save if you made any changes.

Permissions required to perform installation
Performing the Cisco TMSXE installation requires logging into the Exchange Server as a user with specific 
administrator permissions. Before continuing, verify the user account you will use to perform the installation 
has the following permissions:

 n Windows Domain Administrator for the local domain or has delegated administrative access to the OU in 
Active Directory where all accounts are to be created

 n Windows Administrator of the local machine you are installing on
 n Exchange Full Administrator if using Exchange 2003 or Exchange Recipient Administrator for Exchange 

2007 Installs

For organizations where Active Directory and Exchange permissions are segregated and no exception can 
be made to use the Cisco TMSXE software, see Appendix 3. Installing and using Cisco TMSXE with 
separate administrator roles [p.37] for information on installing via manual methods.

During the installation you will also setup a service user on the Cisco TMS Server. If not reusing an existing 
account for the Cisco TMS Service User, you must supply user credentials that can create a new one. The 
user credentials must have the following permissions:
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 n Be a Windows Administrator of the server Cisco TMS runs on.
 n Have a user profile in Cisco TMS and be a member of the Site Administrator's group.
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Before installing
Cisco TMSXE synchronizes Microsoft Exchange calendaring and Cisco TMS scheduling by installing 
components in the backend servers of an Exchange organization. By installing in the backend, all users of 
the organization can benefit from a single installation.

Cisco TMSXE is installed on an Exchange 2003 or 2007 Server, and accounts integrated with Cisco TMS 
must be hosted by the Information Store of the same server. 

Only one Cisco TMSXE installation is required per Exchange organization as long as all users have access 
to the resource accounts hosted by that server. There should never be more than one Cisco TMSXE 
installation in a single domain.

Installations with complex security models where users cannot see accounts across domains should contact 
their Cisco TelePresence sales representatives for assistance in planning more complex deployments. For 
more information on how Cisco TMSXE integrates with your Exchange Organization and details on server 
changes, please refer to the section Impact of Cisco TMSXE installation on existing servers [p.9].

Impact of Cisco TMSXE installation on existing servers
This section is provided as reference for administrators who desire to fully understand the impact of installing 
Cisco TMSXE on their Exchange server.

During installation, the installer makes the some necessary changes in the scope of Domain users, the 
Exchange server, and Cisco TMS server. Changes of significance are listed below.

Changes to the Exchange server and domain
 n The installing user specifies an Organizational Unit (OU) to use as the default location for all accounts 

created by the software. The user is given a choice to create a new OU if desired.
 n An  Active Directory (AD) user account named "TMS-Service" is created in the local domain in the selected 

OU to act as a service account on the Exchange server.
 n A strong password is automatically created for the TMS-Service user. If desired, this can be changed using 

the configuration tool after the installation.
 n A mailbox is created for the TMS-Service account and an inbox sink is registered on the mailbox.
 n On Exchange 2003, two security groups are created for assigning calendar permissions. Note that this 

depends on the Active Directory configuration, see Domain functional level [p.5] for more information.
 n A role-restricted COM+ Application is created on the Exchange server which runs as the TMS-Service 

service account.
 n An installation folder with a log directory is created and the service user is granted access to the log 

directory.
 n A configuration tool is installed to manage the product, and is accessible via a TANDBERG Program Group 

added to the Start menu.
 n Registry keys are created within a TANDBERG hive in the Registry and the TMS-Service user is granted 

access  to these keys.

Changes to the Cisco TMS server
 n A local Windows user account named "tmsconfuser" is created on the Cisco TMS server with regular  

Windows user privileges. A strong password is generated for the account.
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 n Alternatively an existing account can be specified during installation if manually configured.
 n Grants the "tmsconfuser" account the "Exchange Integration Account" permission within Cisco TMS and 

adds it to the Site Administrators Group

Permissions granted to service users
Permissions for service users will be configured automatically when the installer creates them. The  
permissions listed below are required for each service user and must not be restricted.

TMS-service user in Exchange

 n Log on as batch job
 n Read/write permissions to the TANDBERG Key in the registry
 n Write permissions to log files directory
 n Read permissions to log files directory and the installation directory
 n Access to the TANDBERG COM+ package

Note: Do not grant this user any Exchange Administrator Roles to prevent it from accessing other mailboxes

tmsconfuser in Cisco TMS  

 n Login rights to the Windows server hosting Cisco TMS
 n "Book on behalf of" permissions in Cisco TMS
 n  Exchange Integration Service Account set to Yes in its Cisco TMS Profile
 n Booking permission to all systems in Cisco TMS to be integrated

Obtaining the software
Get the Cisco TelePresence Management Suite Extension for Microsoft Exchange installer from our 
software download website. Note that there are separate installers for 64-bit and 32-bit servers. Make sure to 
choose the appropriate installer for your server.

Avoiding custom attribute conflicts
Cisco TMSXE relies on being able to set and read a custom attribute in the mailboxes used for its Exchange 
service account and the resource accounts integrated with Cisco TMS. By default, the attribute used is 
customAttribute1.

In some customer installations, this custom attribute is already in use for other purposes. To avoid attribute 
conflict in these situations, administrators can specify any AD user object field for use by Cisco TMSXE, 
provided that it is replicated to Global Catalog Servers. An example of such a field is extensionAttribute2.

Perform these changes before installing Cisco TMSXE:

 1. Open the Registry Editor regedit.exe.
 2. Navigate to the registry key 

HKEY_LOCAL_MACHINE\SOFTWARE\Tandberg\TANDBERG Management Suite Exchange 
Integration.
If it does not exist, create a new registry key in this location.
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 3. Select the TANDBERG Management Suite Exchange Integration key, and in the right panel, right click 
and select New > String Value. Name the new value TMS Id AD Attribute. Note that this is case 
sensitive.

 4. Double-click the newly created string value, and in the input field enter the name of the AD attribute that 
you wish to use and click OK. Note that this field is also case sensitive.

 5. Close the registry editor.

When running the Cisco TMSXE installer and configuration tool, they will now use the custom attribute ID 
defined in the registry key. If you need to make these changes and Cisco TMSXE has already been installed; 
uninstall, set the key, and then reinstall Cisco TMSXE. 

Deployment best practices

Mailbox servers
Cisco TMSXE is a plugin to Microsoft Exchange 2003 and 2007. To minimize the potential impact on the rest 
of your Exchange organization, we recommend creating a new Exchange mailbox server specifically for 
Cisco TMSXE. This mailbox server should ideally only host the resource mailboxes used to represent video 
conference systems and the service user mailbox used by Cisco TMSXE.

Small deployments
If you have a small number of videoconferencing systems that you want to integrate with Exchange, consider 
using a new virtual machine for this purpose. Server virtualization will simplify both lab evaluations of the 
solution and error recovery operations in a production deployment. There is no hard rule for when a virtual 
machine is sufficient to run Cisco TMSXE, but deployments up to 30 video endpoints can safely run in a 
virtual environment. For larger deployments, we recommend using a physical server.

Other applications on the server
Beware that running other applications that use Exchange Store Event Sinks on the server where Cisco 
TMSXE is installed is not supported. If you do not set up a separate Exchange mailbox server for Cisco 
TMSXE, such applications must be disabled before installation.

Automatic account creation
The Cisco TMSXE installer creates all necessary service and resource accounts. Even though it is possible 
to manually create these accounts beforehand and attach them to Cisco TMSXE during installation and initial 
setup, leaving account creation to the installer and configuration tool is strongly advised unless performed by 
an administrator with extensive knowledge of the product and troubleshooting procedures, should manual 
processes fail.
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Installing and upgrading
All the sections in this chapter must be completed to install Cisco TMSXE. 

Note that Cisco TMSXE supersedes previous TANDBERG Exchange integration products:

 n Users of TANDBERG eXtensions for Microsoft Exchange (TCX) who are upgrading their product on the 
same Exchange server version must use the Upgrade option in the Cisco TMSXE installer.

 n Users of TANDBERG Microsoft Exchange Integration must uninstall the product, remove all components, 
and start with a fresh install of Cisco TMSXE.

If installing Cisco TMSXE in a clustered mailbox environment or with redundant Cisco TMS servers, please 
refer to these appendices before starting your installation:

 n Appendix 1. Using Cisco TMSXE with Exchange 2007 clustering [p.33]
 n Appendix 2. Using Cisco TMSXE with redundant Cisco TMS servers [p.36]

If administrator roles for Exchange, Active Directory, and Cisco TMS are separated in your organization, 
refer to Appendix 3. Installing and using Cisco TMSXE with separate administrator roles [p.37].

Installing the software
 1. Log into the Windows console of the Exchange server where Cisco TMSXE will be installed. Close all 

other running programs and any security/anti-virus software that may hinder installing the software.
 2. Launch the installer.
 3. If the installer finds a previous installation of Cisco TMSXE, it will ask whether you want to perform an 

upgrade. Click Yes to continue. The installer will automatically read the existing settings from the server's 
registry and skip steps where it does not need additional user input. Because of this, not all steps listed 
below may be applicable to your installation. If you wish to modify the previous installation's configured 
values, these can be changed using the configuration tool after the installation has completed.

 4. The installer will verify that all the required Microsoft software components are installed on the server, and 
if not will present a list of components that must be updated. The installer will complete this task for you 
automatically (Internet access required), but may require a restart of the server after the installation is 
complete.

 5. A welcome window will appear on the screen. Click Next.
 6. Read the License Agreement and select I accept the terms…. Click Next to continue. Selecting 'I do not 

accept the terms…' or clicking Cancel will terminate the installation.
 7. Select the destination folder where the software should be installed. To accept the default location, click 

Next. To specify a custom installation path, click Change.
 8. The installer will detect all domain controllers available to the Exchange Server and present them in a drop-

down list. The domain controller selected will used by Cisco TMSXE software when interacting with 
Active Directory. Select your desired server from the drop-down list if necessary, and click Next to 
continue.

 9. Configure the service account to use on the Exchange server. The options available will vary depending on 
whether or not an existing service account was found. These paths are described below.         

Note: The service account used must have the Log on as Batch Job permission in the local security 
policy. Make sure that no Group Policies  override the configuration of this permission.
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Creating a new service account 
If no pre-configured service account is found, the installer will ask whether you wish to create a new account, 
or reuse an existing Active Directory account. In this case, we recommend creating a new service account 
as described below:

 1. Select I want the installer to create the account and click Next.
 2. Specify the OU where the account should be created. Click Browse and locate the Organizational Unit the 

account should be placed in, or click New to create a new OU. Click OK when you have made your 
selection. Then click Next to continue. 

 3. Select which mailbox store should be used for the mailbox of the account. The drop-down list will show all 
available databases on the local Exchange Server. Select one and click Next to continue.

 4. The installer will now create a new account "TMS-Service" with a strong password in the specified OU 
with a mailbox configured as needed for use with Cisco TMSXE in the specified mail database.

Reusing or deleting a detected service account

If a service account exists from a previous installation or manual configuration, it will be detected, and you 
will be prompted to accept the existing user.

To reuse the detected account:

 1. Click Next. 
 2. Provide a password for the service user to Cisco TMSXE. Either:             

 l Reset the password to a strong, auto-generated password.
 l Manually enter a new password.
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 l Enter the existing password for the account.
 3. Fill in the password fields if necessary.
 4. Click Next to continue.

To discard the existing account and specify a new one:

 1. Click Cancel.
 2. Either:    

 l Remove the custom attribute for extensionAttribute1 from the account's mailbox .
 l Delete the account and mailbox altogether .

 3. Restart the installer.
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Enabling Cisco TMS systems in Exchange
Every Cisco TMS system to be made bookable from Exchange must have a domain user account and 
mailbox in the Exchange environment. To operate with Cisco TMSXE, the accounts require certain 
configurations.

Launching the configuration tool
The Cisco TMSXE configuration tool handles creation, configuration, and management of resource accounts 
and can be also used to modify Cisco TMSXE behaviors. 

To make full use of the configuration tool, the user must be a Domain Administrator and Exchange Full 
Administrator (Exchange 2003) or an Exchange Recipient Administrator (Exchange 2007).

In a first-time installation,  Exchange mailboxes must be initialized and configured for each system. For 
upgrades, existing accounts will be reused, but launching the configuration tool is required to allow the 
diagnostics to be run on these accounts:

 1. Launch the configuration tool from the Start menu: Programs > TANDBERG > TANDBERG 
eXtensions for Microsoft Exchange > TANDBERG Configuration.

 2. On startup, the tool will perform a series of self-checks and diagnostics on the configuration of Cisco 
TMSXE and any configured accounts. When possible, it will also repair issues as necessary. Any errors 
will be reported to the user.
 l If no additional accounts are to be added, upgrade users can proceed to Starting the synchronizer 

[p.21].
 l For new installations or upgrades involving new systems, proceed to Defining calendar security groups 

[p.15] before adding systems to your installation.

Note: When Cisco TMSXE has been installed and is operational, new systems added to Cisco TMS must 
also be integrated with Exchange using the configuration tool before allowing the systems to be booked.

Defining calendar security groups
Specifying calendar permissions for groups of users is required if using Exchange 2003 with the default 
booking model and optional if using Exchange 2007 with its default booking model. Before setting 
permissions, define the default security groups so that the groups will be available for all accounts that you 
enable.

If the AD domain functional level is Windows 2000 native mode or higher, the installer will have generated 
two security groups in the organizational unit (OU) of your choice. The groups will be named Video 
Conference Admins and Video Conference Users:

 1. In the configuration tool, switch to the Resource Defaults tab.
 2. Under Resource Calendar Permissions, use the Browse button to select the existing security groups 

from Active Directory for each setting. If needed, you can also create a new security group from the 
browse dialog that opens. 

 3. Permissions can now be defined per group as desired, as described in the  section Permission levels 
[p.16].
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When security groups and permissions are set up using the installer and configuration tool, the tool will add 
the necessary permissions for resource mailboxes as they are added to Cisco TMSXE, and no manual 
configuration of mailboxes is needed.

Manual configuration
If the AD domain functional level is Windows 2000 mixed mode, the installer is not able to create security 
groups for you. You must set up these groups up and apply permissions  to mailboxes manually, without the 
use of the Cisco TMSXE configuration tool.

Once you have created the desired Active Directory security groups:

 1. Log on to Outlook with each resource account's credentials.
 2. From the menu, go to Tools > Options > Calendar Options > Resource Scheduling > Set 

Permissions.
 3. Add each group that should have access to the resource calendar.
 4. Grant each group the appropriate permissions, as described below.

Note that the above steps must be repeated for each resource mailbox to be added to Cisco TMSXE.

Permission levels
 n Editor permissions: Members of the specified group will be able to edit meetings in resource calendars 

created by all users. This permission level should only be granted to administrators.
 n Author permissions: Members of the specified group will be able to create meetings in resource calendars, 

but only edit their own meetings—not those created by other users.
 n Reviewer permissions: Members of the specified group will be able to open resource calendars and view 

free/busy information. This permission level is not available in the Cisco TMSXE configuration tool, but can 
be used if manually applying permissions to resource mailboxes.

CAUTION: Creating and modifying bookings from resource calendars is no longer supported by Cisco 
TMSXE. This functionality should only be used in advanced troubleshooting scenarios.

With security groups and permission levels defined, proceed to adding systems to Cisco TMSXE.

 

Adding the systems
CAUTION: Depending on your Active Directory configuration, account creation/deletion/modification may 
take upwards of an hour to replicate across domain controllers. If experiencing errors or inconsistencies with 
account creation, close the configuration tool and allow more time for your Active Directory changes to 
propagate. See the Microsoft article How the Active Directory replication model works for more detail.

 1. Switch to the Operations tab in the configuration tool.
 2. The initial screen shows an overview of systems found in Cisco TMS and any linked accounts in 

Exchange. The left hand column presents all endpoints, rooms, and recording devices found on the 
configured Cisco TMS server. The right hand column lists all Exchange accounts that are integrated with 
Cisco TMS via Cisco TMSXE.
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 3. Select one or more Cisco TMS systems that you wish to enable in Exchange from the left hand list. Use 
the Shift or Control keys to select multiple systems, then click the → button.

 4. The dialog that appears will walk you through associating the system with an Active Directory account and 
mailbox. Use the Next/Previous buttons to switch between systems. The system being configured is 
displayed on the top left. The dialog allows you to choose an option for each selected system individually. 
When multiple systems are selected, the OK button will be disabled until a choice has been made for each 
system.      
 l To create a new account for the system:       

 i. Ensure that Create an AD account… is selected. The center panel displays a list view of your 
Active Directory's organizational structure. 

 ii. Expand the tree if necessary and highlight the Organizational Unit (OU) where the new account 
should be created. The mailbox and Active Directory user will automatically be created by the 
configuration tool. The system's TMS ID and System Name from Cisco TMS will be used as the 
AD account's username and display name respectively. The mailbox will be created in the Mail 
Store designated during installation.

 iii. If you wish to use these same setting for all remaining accounts, click Create the remaining 
accounts in this folder, or use Next/Previous to switch to the next system.

 iv. In Exchange 2003 installations, the configuration tool will ask for a password to use for the newly 
created accounts. Selecting Reset password for all… will also set the password for accounts that 
are being re-used. In Exchange Server 2007 installations, an AD account with no password will be 
created and the user account will be disabled, as is normal for resource accounts in Exchange 
2007.    

Note: The password for resource accounts is only needed for administrators that may wish to log 
into the account/mailbox directly. The resource account passwords can be changed using 
standard AD tools afterward without affecting Cisco TMSXE.

 l To use an existing account       
 i. Select Use an Existing AD Account. The center panel will show you your domain's organizational 

structure. Navigate the tree to find the desired AD Account or use the Search feature. Only user 
accounts that have their mailbox on the local server will be displayed. Click on the user account you 
wish to associate to this Cisco TMS system.

Note: If an OU has more than 1,000 entries, only the first 1,000 will be displayed. When OUs are very 
large, the search function must be used.

 ii. Repeat the above steps using Next/Previous to toggle between the systems until a choice has 
been made for each system.

 iii. Click OK to continue.

 5. After choices have been made for all selected systems, a summary of your choices will be presented. If 
the information is correct, click OK, or click Edit to return to the previous screen.

 6. If systems were associated with existing accounts, you will be asked whether to import existing meetings 
from Exchange. This feature should only be used for a fresh, first-time installation, not if you are upgrading 
and already have links between Cisco TMS and Exchange. See Importing existing meetings [p.18] for 
more information.

 7. The configuration tool will now perform the tasks as instructed, and a status screen shows the progress of 
the individual systems and the overall progress. This process can take some time depending on the 
number of systems you are importing and design of your Active Directory.

 8. When complete, click OK and the Operations tab will be displayed with the newly added systems in the 
right-hand column.
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Importing existing meetings
If one or more of the systems imported were associated with existing accounts, you will be asked whether 
existing events from the calendars of those accounts should be imported into Cisco TMS. Click Yes to 
import or No to skip this step.

If there are any issues booking an existing meeting in Cisco TMS, the meeting organizer will receive an email 
notification detailing any necessary actions.

Note: Meetings with no end date and meetings with yearly recurrence cannot be booked in Cisco TMS and 
will not synchronize to Cisco TMS. After Cisco TMSXE is installed, any meetings of these types must be 
modified using Outlook to a new meeting so that they have an end date. A yearly recurrent meeting must be 
rebooked as separate meetings.

Exchange 2003: Forcing the Recipient Update Service to start 
processing
In Exchange 2003, the Recipient Update Service (RUS) is the Exchange component responsible for updating 
address lists in Active Directory. When creating new resource accounts, it could take some time before they 
appear in Active Directory, especially if you have an AD domain that spans different physical locations. The 
update interval for the Recipient Update Service is configurable in the Exchange System Manager. If the 
interval is set to Always Run, changes will be replicated continuously.

When enabling resource accounts in Exchange 2003 deployments, the Cisco TMSXE configuration tool 
displays a Run RUS button after all accounts have been configured and tested. If the update interval for the 
Recipient Update Service is not set to Always Run, click the button to force the processing of new mailboxes 
and allow end users to book the newly created video resources immediately.

Manually enabling auto-accept in Exchange 2003
When enabling resource accounts in Exchange 2003, the configuration tool will turn on auto-accept of 
invitations in the resource's calendar options. In some scenarios, the methods necessary to enable this 
setting are not available, and the operation will fail. The configuration tool will then report that enabling auto-
accept did not succeed.

To manually enable the setting:

 1. On a client computer with Outlook installed, create a new Mail profile using the Mail Control Panel:
 a. In the Mail profile, click Show Profiles, and add a new Mail profile. Use the Exchange Mailbox 

credentials and properties of the resource account you are trying to modify. 
 b. Set Outlook to prompt for which profile to use when launching Outlook.

 2. Open Outlook, select the profile configured for the resource account and supply the necessary credentials.
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 3. When the mailbox opens, select from the menu Tools > Options.             
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 4. In the Preferences tab, click Calendar Options.

 5. In Calendar Options, click Resource Scheduling.             

 6. Select Automatically accept meeting request and process cancellations and click OK
 7. If you are prompted about setting default permissions, accept the change.
 8. Click OK to close the Calendar Options, and again to close the Options panel. 
 9. Close Outlook.
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Starting the synchronizer
The synchronizer is a component of Cisco TMSXE that runs on the Exchange Server and synchronizes 
bookings and modifications made in Cisco TMS to Exchange calendars.

The synchronizer is set up by the installer, but is idled in new installations until the administrator has enabled 
all the systems in Exchange using the configuration tool. When all systems have been enabled in Exchange 
using the configuration tool, the synchronizer must be started. During upgrades, the synchronizer's state is 
saved before it is idled until reactivated from the configuration tool.

To start, restart, or reactivate the synchronizer, open the configuration tool and switch to the Operations tab:
 n If the button says Restart Synchronizer, the synchronizer is already running.
 n If the button says Start Synchronizer or Reactivate Synchronizer, the synchronizer has stopped or has 

been idled. 
 a. Click the button to start the synchronizer for a new or upgraded installation. A  warning will be 

displayed notifying you that all systems must be configured before proceeding. 
 b. Click Yes if all systems are ready.

The synchronizer will work in the background to update the Exchange calendars of integrated systems with 
all meetings that exist for those systems in Cisco TMS. This process can take several hours on the first 
synchronizer startup  in installations with many bookings. 

The resource account's calendars will not have complete free/busy information for all future meetings until 
the synchronizer has processed all meetings and caught up, but you do not have to wait for this to complete 
before continuing the installation and using the product. Cisco TMSXE will properly reject new meeting 
requests that would conflict even if the free/busy and resource calendars are not up to date yet.

Note: We recommend against restarting the synchronizer when new systems are added. Restarting the 
synchronizer is not needed in normal operation and is only for specific, advanced scenarios. A restart  will not 
affect any meeting data, but it is a process that can take many hours to complete.
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Tuning security settings 
After installing, administrators should review any security restrictions they wish to implement with booking of 
the integrated resource accounts. How permissions are controlled depends on the booking model and version 
of Exchange.

Exchange 2003 
With Exchange 2003 using synchronous booking, booking privileges are only available to users who are 
members of the user group with    Author access in the configuration tool. In new installations, this group may 
be empty and users will not be able to book these systems until this group is populated. Configure this 
group's membership in Active Directory using the AD Users & Computer snap-in as desired to enable users 
to start booking.

Exchange 2007
For Exchange 2007 installations, access to booking the resources is controlled via Resource Booking 
Policies. The default setup on accounts will have AllBookInPolicy set to true, meaning all users can book 
the resource as long as the request falls within the restrictions defined on the resource account. 

New accounts created by the configuration tool will have the default Microsoft Exchange restrictions 
enabled. These will limit how a user can book a meeting from Outlook, but will not limit bookings made from 
Cisco TMS or directly in the Resource's calendar. Administrators may need to tune these restrictions to their 
desired values to control booking by Outlook users.

Administrators may configure the standard CalendarSettings of the Exchange resource accounts as they 
wish, including setting up delegates and configuration for handling In-Policy and Out-of-Policy requests. 
Administrators should not modify the following settings; they should be left as configured by the configuration 
tool:

MailboxCalendarSetting Parameter Configured Value

AutomateProcessing AutoAccept

Identity <domain>/TMS-<systemId>

For more information on Managing Resource Scheduling Parameters see:

 n Managing Resource Scheduling: http://technet.microsoft.com/en-us/library/aa996338.aspx
 n Set-MailboxCalendarSettings: http://technet.microsoft.com/en-us/library/aa996340.aspx
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Deploying the Cisco form
Cisco TMSXE includes a custom form that can be used to add functionality to Outlook clients when creating 
or modifying videoconference meetings. Available settings include specifying conference parameters and 
adding external participants. A detailed description of the available functionality can be found in the Cisco 
TMSXE User Guide.

The deployment and use of this form is optional. The form can also be added to an installation at any time in 
the future.

If opting to use the Cisco form, we recommend that it be placed in the Organizational Forms Library, which 
makes for simple distribution to all users and will automate any future updates to the form. You must either 
use an existing Organizational Forms Library on your Exchange server, or create a new one before the 
custom form can be imported to the library. 

Form deployment requires the following three steps for a new installation:

 1. Forms library creation
 l The Organizational Forms Library in Exchange 2003 [p.24]  
 l The Organizational Forms Library in Exchange Server 2007 [p.26]
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 2. Publishing the Cisco form [p.29]
 3. Configuring clients to use the form [p.29]

Administrators performing an upgrade need only refer to step 2.

Note: The form can also be loaded manually per Outlook client, without using the Organization Forms 
Library. To do this, perform the steps in the Configuring clients to use the form [p.29] section and specify a 
local copy of the VideoConference.oft file. Any future updates to the form must then be manually performed 
by repeating the same steps.        

The Organizational Forms Library in Exchange 2003
Make sure you are logged into the Exchange server with full  administrator rights. 

 1. Open the Exchange System Manager.
 2. Go to Administrative Groups and then select the group containing the Exchange Server on which you just 

installed the Exchange Integration component. This is normally the Administrative Groups/First 
Administrative Group.

 3. While viewing the System Folders, right-click on EFORMS Registry and select New > Organizational 
Form.

 4. A property page for the new Organizational Form library will be displayed. Fill in a suitable name of your 
choice and (optional) description of the Organizational Forms Library. 

 5. Choose English (USA) as E-forms language.
 6. Click OK to save the Organizational Forms Library.         

Note: If English (USA) is not listed, a Forms Library for that language already exists and another can not 
be created. In this scenario, you must use the existing folder to publish the form. Right-click on any folder 
listed under EFORMS REGISTRY, select Properties and find the one which is using English (U.S.), 
then use that existing folder for the remaining steps.

 7. In order to publish the Cisco form in the Organizational Forms Library, an Outlook user needs to be granted 
Owner permissions to the Organizational Forms Library. This is done by right-clicking on the new folder 
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and selecting Properties. In the pop-up window, select the Permissions tab.             
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 8. Click the Client Permissions button and a new dialog appears.             

We recommend only giving the Owner role to one user, preferably an administrator, who will publish the 
form. Because the Default entry is granted the Reviewer role by default, users will automatically get the 
required permissions to access and use the form.

 9. Using the Client Permissions dialog, add a user and set its role to Owner and add any  User Groups with 
Reviewer role.

 10. Click OK to save the permissions.
 11. Click OK again to save the properties of the new Organizational Form.

The Organizational Forms Library in Exchange Server 2007
Exchange Server 2007 Environments are not dependent on Public Folders and may lack the required 
infrastructure to support the Organizational Forms Library. The  steps required to be able to publish the Cisco 
form will therefore vary based on whether Public Folders are present and on how Exchange 2007 was 
installed.

Mixed environments
If Exchange Server 2007 was installed along side or into an Exchange Server 2003 organization, a public 
folder database will have been created for the first 2007 server. In these cases, the existing Public Folder 
Database can be used, and replication should already be configured between the Public Folder Databases in 
Exchange 2003 and Exchange 2007.
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In these environments, if an Exchange 2003 Server is available, an administrator can follow the instructions  
for The Organizational Forms Library in Exchange 2003 [p.24]  and perform the steps on that server. Forms 
will replicate to the Exchange 2007 Server and therefore be available to all Outlook versions. 

If using an Exchange 2003 server is not an option, proceed to the section below.

Creating the Organizational Forms Library in Exchange Server 2007
During the installation of the first Exchange Server 2007 as a new Organization, the setup prompted the user 
with "Do you have any client computers running Outlook 2003 and earlier or Entourage in your organization?". 
If the user answered Yes, a Public Folder database and Organizational Forms library was automatically 
created. If they answered no, no Public Folders would have been created and creating a Public Folder 
Database is most likely required to be able to publish the Cisco form.

If Exchange Server 2007 was installed alongside an existing Exchange Server 2003 environment, the Public 
Folder database should have been created and configured to replicate with the existing 2003 Public Folder 
database and Organizational Forms Library.

The steps below cover the basic concepts for setting up Public Folders and an Organizational Forums library 
in Exchange Server 2007. Due to the high variation in installations, these are not step-by-step instructions 
but rather a collection and guide to the reference material provided by Microsoft regarding Public Folders and 
Organization Forms Libraries in Exchange 2007. Administrators should reference Microsoft's documentation 
for more detailed information regarding Public Folders.

Relevant Microsoft articles

Title URL

Understanding Public Folders http://technet.microsoft.com/en-us/library/bb397221.aspx

Understanding Public Folder Replication http://technet.microsoft.com/en-us/library/bb629523.aspx

Managing Public Folders http://technet.microsoft.com/en-us/library/bb124411.aspx

How to Create a New Public Folder Database http://technet.microsoft.com/en-us/library/bb123687
(EXCHG.80).aspx

How to View or Configure the Settings of Public 
Folders

http://technet.microsoft.com/en-us/library/bb123509.aspx

How to View or Modify Public Folder Database 
Settings

http://technet.microsoft.com/en-us/library/bb124522.aspx

How to Create an Organizational Forms Library in 
Exchange 2007

 n http://technet.microsoft.com/en-
us/library/cc540468.aspx

 n http://support.microsoft.com/kb/933358

Configuring Public Folder Permissions http://technet.microsoft.com/en-us/library/bb310789.aspx

Setting up an Organizational Forms Library
These steps must be performed by an Exchange Administrator. See the supporting Microsoft articles for 
specific permissions.

 1. On an Exchange Server, open the Public Folder Management Console:     
 a. Open the Exchange Management Console.
 b. Click on Toolbox.
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 c. Double-click on Public Folder Management Console.       
 o If there is an existing Public Folder database, the console will connect to it, and the navigation tree 

will list both Default Public Folders, and System Public Folders. Public Folder databases can 
also be found by going to Exchange Management Console > Server Configuration > Mailbox 
and viewing the databases for each server.

 o If no Public Folder database exists, you will need to create one and mount it. See How to Create a 
New Public Folder Database for assistance.

 2. Expand System Public Folders so that EFORMS REGISTRY is visible.
 3. Using the Exchange Management Shell, create a new Public Folder named Cisco Form under EFORMS 

REGISTRY for the Organizational Forms Library.         
Example: New-PublicFolder –Path "\NON_IPM_SUBTREE\EFORMS REGISTRY" –Name "Cisco 
Form"

 4. Switch to a computer running Outlook with a valid mail profile.     
 l If the administrator who created the Public Folder can use Outlook with a valid mailbox, proceed to step 

5.
 l If not, permissions must be granted for a different user to perform the remaining steps. Run the 

following commands in the Exchange Management Shell, substituting the correct domain\username: 

Add-PublicFolderClientPermission –Identity "\NON_IPM_SUBTREE\EFORMS REGISTRY\Cisco" 
–User "domain\username" –AccessRights Owner
 Add-PublicFolderAdministrativePermission -Identity "\NON_IPM_SUBTREE\EFORMS REGISTR
Y\Cisco" –User "domain\username" –AccessRights AllExtendedRights

 5. Download and extract the MAPI Editor from http://mfcmapi.codeplex.com/  
 6. Launch the  executable.
 7. From the Session menu, select Logon and Display Store Table. If prompted, select the correct mail 

profile to use. The screen will update to show the stores from the user's profile.                         

 8. Right click the row with the Display Name Public Folders and select Open Store
 9. Expand the tree in the left panel down to the Cisco form folder. Public Root > NON_IPM_SUBTREE > 

EFORMS REGISTRY > Cisco Form
 10. In the center panel, scroll through the list and find the entry starting with PR_URL_NAME and select it
 11. From the Property Pane menu, select Modify Extra Properties and a new Extra Properties dialog will 

appear.
 12. Click Add and the Property Tag Editor dialog will appear
 13. Click Select Property Tag.
 14. Scroll through the list and find PR_EFORMS_LOCALE_ID, select it and click OK
 15. Click OK to close the Property Tag Editor. Click OK again to close the Extra Properties Window.
 16. The PR_EFORMS_LOCALE_ID Property will now be listed with a red icon next to it in the property list.
 17. Double-click PR_EFORMS_LOCALE_ID and in the unsigned decimal field, enter 1033 and click OK.
 18. Close the MAPI Editor.
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Tip: For Microsoft's description of the steps using the MAPI Editor, refer to         How to create an Organizational 
Forms Library in Exchange 2007, see link in reference table.

Publishing the Cisco form
When the Organizational Forms Library is in place, the Cisco form is published using an Outlook client.

Acquiring the form
On the server where Cisco TMSXE was installed:

 1. Locate the Video Conference Form folder created in the installation path, usually under   C:\Program 
Files\Cisco\Conferencing eXtensions for Microsoft Exchange (or, if upgraded from a version older than 
2.3, C:\Program Files\TANDBERG\).

 2. From this folder, copy the file VideoConference.oft  to a client computer with Outlook installed.

Publishing from Outlook 2007
 1. Log into Outlook as the user that has Owner permissions for the forms library.
 2. Make sure you do not have a booking request open.
 3. In the menu go to Tools > Forms… > Design a Form…
 4. Change the Look In dropdown menu to User templates in File System.
 5. Click Browse.
 6. Locate the .oft file on the computer, and open it. 
 7. From the Publish dropdown button, select Publish Form As....   
 8. In the dialog that opens, change the Look In dropdown menu to Organizational Forms Library
 9. Enter names in the two fields  as described below:         

 l Display name: Meeting
 l Form name: VideoConference

 10. Click Publish when complete.

The form will now be published and available for users to choose as their appointment form.

Configuring clients to use the form
Publishing the form makes it available to users, but does not force their Outlook client to use the form. 
Configuring Outlook to use the form is a one-time client configuration that can be done by each user, or by 
making changes to the Microsoft Windows Registry. Registry changes can be done automatically using 
methods such as Group Policy.

The Microsoft article How to globally change the default forms in Outlook by using the Forms Administrator 
utility describes and links to a utility for creating registry keys to change the default form.

Manually configuring clients to use the form
To configure the form per computer, each user must complete the following steps:
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 1. Open the Outlook client
 2. From the Folder view, right-click the calendar icon and select Properties.
 3. The Calendar Properties window will open with the General tab selected.
 4. Select Forms… from the drop-down menu for the When posting to this folder, use option
 5. A dialog will open. In the Look In drop-down menu, make sure Organizational Forms Library is 

selected.         

 6. An entry named Meeting will be displayed. Select it and click Open.
 7. You will be returned to the Calendar Properties page. Click OK to save your changes

The client will now use the Cisco form for all Calendar actions and have the Cisco tab available when 
creating new booking requests.

Note: Because Outlook security does not allow previewing of custom forms, when using the reading pane in 
Outlook, calendar events cannot be previewed if the entry was created using the Cisco form. Users must 
open the item to view it. 
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Uninstalling or repairing the installation

Uninstalling Cisco TMSXE
To uninstall the product, either:

 n Select Uninstall from the product's group in the Start menu on the Exchange Server.
 n Use Add/Remove programs from the server's Control Panel of the server.

The program will leave its log directory, registry keys, and associated accounts in place to accommodate 
future installations or upgrades.

Note: Given the standard options of the installation software, it is possible to select Modify as an option if 
the setup file is launched after the product is installed. As there are no options to install only individual 
elements of the product, however, this choice does not allow you to make any changes.

Removing the product completely
If an administrator wishes to remove all elements of the installation, the following must also be deleted after 
uninstalling:

 n The installation and logs directories. (Default location C:\Program Files\Cisco\Conferencing eXtensions for 
Microsoft Exchange, or, if upgraded from a version older than 2.3, C:\Program Files\TANDBERG\)

 n The Registry key at HKEY_LOCAL_MACHINE\SOFTWARE\TANDBERG\TANDBERG Management 
Suite Exchange Integration

 n The TMS-Service user from Active Directory and its associated mailbox
 n The tmsconfuser user account from the Windows Server hosting Cisco TMS and the user profile in Cisco 

TMS
 n Resource accounts and their mailboxes as desired. Existing accounts may of course be used for 

Exchange-only booking if desired.

Note: Due to Active Directory replication, a new installation of Cisco TMSXE should never be attempted 
immediately after removing or modifying service or resource accounts. Sufficient time must be given to allow 
Active Directory replication to complete before attempting to install Cisco TMSXE again.

Repairing
If a problem is suspected with the server software itself, a repair is possible. The repair process will copy all 
needed files to the server ensuring all files are correct and in the proper location.

To repair the installation:

 1. Start the original Cisco TMSXE setup file on the server, if available. If not, download the Cisco TMSXE 
installer, making sure the versions are identical.
 l To check the version of the installed software, see the splash screen of the configuration tool.
 l The installer file has the version number in the file name along with a reference to whether it is for 64bit 

(x64) or 32bit (w32)
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 2. Click Next and from the option menu, select Repair.
 3. Click Next and step through the wizard to complete the repair process. 

After the repair is done, the configuration tool will start automatically.
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Appendix 1. Using Cisco TMSXE with Exchange 
2007 clustering
Cisco TMSXE has been designed to be compatible with a Clustered Mail Server created using the 
Continuous Cluster Replication (CCR) model of Exchange 2007.

When an organization uses Exchange Clustering, Cisco TMSXE can still be installed on another Exchange 
Server within the organization that is not part of a cluster. This is true for both Exchange 2003 and 2007 
installations. 

In a Clustered Mail Server (CMS) setup, Cisco TMSXE is installed on each node in the Exchange cluster. 
Note that Cisco TMSXE itself will not be clustered, and therefore will not show up in the 
Services/Applications of the Failover Management Console. Instead, the Cisco TMSXE integration on each 
node follows the state of the Exchange Clustered Server and is only active when the local server is the active 
node in the cluster.

Clustering requirements
Installing on a cluster requires some additional restrictions on the standard Cisco TMSXE requirements:

Product Details

Exchange 2007 Server Service Pack 1               3 CCR Clustered Mail Server required.

Windows Server 2008 64bit Service Pack 2 Enterprise or Datacenter Edition required.

Note: Cisco TMSXE  2.3.1 has an open caveat with Windows Server 2008 in some environments. Refer to 
the Server requirements [p.5] section for details.

Installation
These instructions assume your Clustered Mail Server (CMS) is already installed and operational. For 
assistance setting up and configuring your Clustered Mail Server, refer to the Microsoft article Installing 
Cluster Continuous Replication on Windows Server 2008.

The installation on cluster nodes follows the same general steps as a stand-alone installation of Cisco 
TMSXE with minor differences. Follow the steps below to perform a first time installation.

 1. Manually create a service user: the service user that will be used by Cisco TMSXE on the Exchange 
Server should be created manually rather than allowing the installer to create the account.

 2. Create a new local domain user with a strong password to act as a service account. The TMS-Service 
account should have a mailbox created on the storage group hosted by the Clustered Mailbox Server. The 
TMS-Service account must have an SMTP email address that is reachable from the mail server used by 
Cisco TMS.

 3. As an administrator, log into each Windows server in the cluster and add the local security policy Log on 
as Batch Job permission for the TMS-Service user. Refer to the Microsoft article Assign user rights for 
your local computer for assistance.

 4. Add Cluster permissions for the TMS-Service user to be able to check the state of the cluster. Note that it 
will not make any changes to the actual cluster.
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 a. Open the Failover Management Console in Windows.
 b. Right-click on your cluster and select Properties. 
 c. Under the Cluster Permissions tab, click Add and select your TMS-Service account. 
 d. Grant the  account Full Control. 
 e. Click OK to save the changes.

 5. Install on the Active Node: You will perform the complete installation of Cisco TMSXE on the active node 
of the cluster as if it were a stand-alone installation following the instructions under the Installing and 
upgrading [p.12] section with the following exceptions:
 l When prompted to specify the Exchange Service User, select I want to use an existing domain account 

and select the TMS-Service account you previously staged. When prompted for the password for the 
Exchange Service User select the I have the password and will provide it below option and enter the 
password previously created for the TMS-Service user. The installer can not change or reset the 
Service User's password in Active Directory when in clustered mode.

 l Note that you cannot use replication for a Public Folder database hosted on a CMS server. A Public 
Folder database can be on the CMS server, or off the CMS server, but not both.

 6. When the installation is complete, follow the instructions in the Installing the software [p.12] section for 
each of the passive nodes of the cluster with the following exceptions:
 l The installer will detect the presence of your existing Exchange Service Account. When prompted for 

the password for this account, select the I have the password and will provide it below option and enter 
the password previously created for the TMS-Service user.

 l Only perform the server software installation itself, the other steps of installation do not need to be 
repeated.

 7. Any configuration tool customizations on the Configuration and Resource Defaults tabs must be 
repeated on each node by running the configuration tool on the node and updating the settings.

Upgrades
To upgrade an existing Cisco TMSXE installation on a Clustered Mailbox Server you must run the software 
installation on each of the cluster nodes with the following additional requirements:

 n Upgrade the active node in the cluster first.
 n Run the software installation steps and when the installer detects the existing Exchange Service account, 

select the option I have the password and will provide it below, then enter the password previously created 
for the TMS-Service user. The installer cannot change or reset the service user's password in Active 
Directory when in clustered mode.

 n After installing the software on the active node, repeat the installation on each of the passive nodes.

Uninstalling Cisco TMSXE
To remove Cisco TMSXE from a Clustered Mailbox Server, you must run the software uninstall instructions 
on each node in the cluster. You can follow the  instructions in the Uninstalling or repairing the installation 
[p.31] section. When running the uninstall on each node, at least one of the nodes must be the CMS active 
node to complete the uninstall and disable the sinks on resource accounts.

Operational changes when using a Clustered Mail Server
 n Cisco TMSXE  automatically follows the state of the Clustered Mail Server and takes no interaction from 

the administrator to failover. The Cisco TMSXE installation on each node independently starts and stops 
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as necessary.
 n The start-up tests run when the configuration tool is opened will show the state of the current node as 

active or passive. You can also see the node state in the configuration tool as the synchronizer button on 
the Operation tab will be disabled when the node is not active.

 n Unlike a stand-alone installation where you should update the Exchange service user password via the 
configuration tool, when in a clustered mode, you must update the password in Active Directory first, and 
then update the Cisco TMSXE installation on each node. The configuration tool cannot update the 
password in Active Directory for the service user, only the locally stored value.

 n Most of the configuration elements of the Cisco TMSXE installation shown on the Configuration and 
Resource Defaults tabs are stored locally on each node, and therefore must be updated on each node if 
changed. To update the settings, open the Configuration tool on each node and update the value.

 n Updating the sender email address and display name on the Configuration tab must be updated on the 
active node for the change to take effect or test. Changes here will automatically propagate to the other 
nodes when a node becomes the active node.

 n Using the features on the Operations tab of the configuration tool, including adding/removing resources 
and starting/stopping the synchronizer must be performed on the active node. 
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Appendix 2. Using Cisco TMSXE with redundant 
Cisco TMS servers
If your Cisco TMS installation includes multiple  front-end servers in a redundant or fail-over scenario, some 
additional requirements apply when installing and configuring Cisco TMSXE. This section provides advice on 
how to ensure that Cisco TMSXE   will continue to work in your redundant or failover scenario.

Before installing
The Cisco TMS service account is normally created by the installer as a local Windows user. Because Cisco 
TMSXE should be able to use any of the Cisco TMS servers, a domain user account should be used instead 
to make the credentials work on any of the servers.

 1. Create or designate a Domain user account you will use as the Cisco TMS side service account.
 2. Using this account, open a web browser and log into the Cisco TMS web interface to create a user profile 

for the user. 
 3. When complete, close your browser.

Installation
The normal installation steps can be followed, taking note of the following specifics:

When prompted to select the Service Account for TMS, select the option I have created a service user on 
the TMS server and enter the credentials of the Domain user you designated to be the service user. For the 
Cisco TMS address, be sure to enter the address that is shared by your Cisco TMS servers (the DNS 
hostname, or load-balanced address). 

CAUTION: Do not select the HTTPS option unless all servers have been properly configured for HTTPS 
operation.

Operation
There is no change in operation compared to a traditional Cisco TMS. By using the shared or load-balanced 
address for the Cisco TMS server in the configuration tool,Cisco TMSXE will connect to a live Cisco TMS 
server like any other user.
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Appendix 3. Installing and using Cisco TMSXE 
with separate administrator roles
Cisco TMSXE normally requires the installing and operating user to be both a Local Domain administrator 
and an Exchange Full Administrator (or Exchange Recipient Administrator for Exchange 2007 installations).

In some organizations, these roles are explicitly separated. This section  provides additional guidance on how 
Cisco TMSXE can be installed and operated in an environment where the Active Directory and Exchange 
administrative roles are separate.

Assumptions
The following are the assumptions about the customer environment for these instructions.

 n An Admin Group is responsible for creating users, groups, and mailboxes for new users.
 n An Exchange group is responsible for ongoing operation of Exchange servers and mail processes.
 n The Exchange group has local administrative rights to the Exchange server, but does not have Domain 

Administrative rights.
 n The users installing the product are aware of any replication delays associated with their Active Directory 

implementation—how they affect propagation of changes in AD objects and permissions and any waits 
that are required before changes will take effect.

 n The process description assumes this is a first-time installation of Cisco TMSXE.

For common terminology purposes in this appendix, the user from the Admin group will be called the AD 
admin. The user from the Exchange group will be called the Exchange admin.

 n AD admin is a member of Domain Admins.
 n Exchange admin is a Local Administrator and delegated Full Exchange Administrator permissions (or 

Exchange Recipient Administrator in Exchange 2007).

Before installing
 1. The AD admin must create or decide which OU in Active Directory will be used for accounts related to 

Cisco TMSXE. Accounts are not required to be in the same OU, but the policy should be followed for 
consistency with the standard product.

 2. The Exchange admin decides which Exchange server and information store will be used for the Exchange 
Integration (all mailboxes for integrated accounts must be located in information stores on the same 
Exchange Server).

 3. The AD admin must create a new domain user or designate an existing user to be the Exchange service 
user. The remainder of the instructions will refer to this account as TMS-Service. When creating a new 
account, create a mailbox for the TMS-Service user:
 l The mailbox must be in an information store on the specified Exchange Server.
 l If re-using an existing account and the mailbox for the TMS-Service user not stored on the specified 

Exchange Server, the Exchange admin must move the user's mailbox to the specified Exchange 
Server before proceeding. 

 l The account must have an SMTP email address that is reachable from the mail server used by Cisco 
TMS.
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 4. The AD admin must set the extensionAttribute1 property on the TMS-Service user to be TMS-Service.                  
 l Exchange 2003: Using the AD Users and Computers tool:

 i. Enable Advanced Features from the View Menu.
 ii. Open the user properties.
 iii. On the Exchange Advanced tab, click Custom Attributes and 
 iv. Edit the value of extensionAttribute1 to be TMS-Service.

 l Exchange 2007: Using Exchange Management Console:
 i. Open the mailbox properties.
 ii. On the General tab, click Custom Attributes.
 iii. Edit the value of extensionAttribute1 to be TMS-Service.

 5. The AD admin or Exchange admin must make the TMS-Service account a local Windows Administrator of 
the specified Exchange Server.

 6. The AD admin or Exchange admin must grant the Log on as Batch Job Local Security Policy to the TMS-
Service account on the specified Exchange Server. Ensure no Group Policy setting will block or remove 
this permission. See Assign user rights for your local computer for assistance on assigning user rights for 
your local computer.

 7. The AD admin must create or identify a Windows user account that can log into the Cisco TMS server to 
be the Cisco TMS Side Service user. The user account can be a local Windows account on the Windows 
Server hosting Cisco TMS or a domain user. We will refer to this account as tmsconfuser.                   

 a. Log on to Cisco TMS with Site Administrator privileges.
 b. Go to Administrative Tools > User Administration.      

 o If the tmsconfuser account has never logged into Cisco TMS, create a new user profile.
 o If the account has logged in previously, find the existing user profile and click Edit.

 c. Ensure that the username of the profile matches the username of the service account.
 d. Set the Exchange Integration Service Account value to Yes.
 e. Set the Email address of the profile to be the email address of the TMS-Service account created in the 

earlier steps.
 f. Ensure that the user is a member of a Cisco TMS group that has the book on behalf of permission and 

book permission on all systems that will be integrated. We recommend using the Site Administrator 
group, which will allow access to all systems.

 g. If users will be given access to resource calendars so they can interact with the calendars directly 
(required if using Direct Resource Booking), the AD admin must create or designate an existing 
security group for the 'Editor' role and 'Author' security groups that will later be granted permissions to 
the resource's calendars.

 h. Save the profile.

Staging the resource accounts
These steps will outline how to prepare a resource account for use with the Cisco TMSXE integration. These 
steps should be repeated for each resource account to be integrated, and anytime you need to integrate a 
new system and be completed before trying to enable the corresponding Cisco TMS system using the 
Configuration tool.

 1. Log into the Cisco TMS web interface and find the Cisco TMS System ID of the system that will be 
associated with this resource account. This can be seen by looking at the View Settings page for the 
system in Navigator. Example ID = 15

 2. If an existing resource account is going to be reused, have the Exchange admin move the mailbox to an 
Information Store on the Exchange Server where Cisco TMSXE is installed. If no existing resource 
account is going to be reused, have the AD admin create a new Active Directory user and mailbox for the 
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Exchange Resource account. On Exchange 2007, be sure to create a mailbox of type room or equipment. 
The mailbox for the user must be located on an Information Store on the Exchange Server where Cisco 
TMSXE is installed.
Most of the account's properties, such as username, password, display name, and email address are not 
significant to the Integration and can be whatever values you chose. It is recommended you set the 
Display Name value to the same name as the matching system in Cisco TMS.

 3. The AD admin must set the extensionAttribute1 property on the resource account to TMS-xx, where "xx" 
is replaced with the numeric ID found in step 1, for example, TMS-15.    
 l Exchange 2003: Using the AD Users and Computers tool, enable Advanced Features from the View 

Menu, open Properties for the user, select the Exchange Advanced Tab, click Custom Attributes and 
edit the value of extensionAttribute1 to be TMS-15.

 l Exchange 2007: Using Exchange Management Console, open the Properties of the Mailbox, on the 
General tab, click Custom Attributes and edit the value of extensionAttribute1 to be TMS-15.

 4. The AD admin must grant send as and receive as permissions for the TMS-Service account to this 
resource account.              
 l Exchange 2003: Using AD Users and Computers, enable Advanced Features from the View Menu, 

open the Properties of the resource account. Select the Security tab, and click the Advanced Button. 
Click Add and specify the TMS-service account. A new window appears, change the Applies to drop-
down to This object only and add the send as and receive as security permissions in the Allow column. 
Click OK and OK again to close the Advanced Security window.

 l Exchange 2007: Use the Exchange Management Shell to grant the send as and receive as 
ExtendedRights on the resource account to the TMS-Service account. An example is shown below, 
replace the Resource and User accounts names as necessary:     
Add-ADPermission -Identity domain\ResourceName –User domain\TMS-Service 
-ExtendedRights ("send-as", "receive-as") -InheritanceType All

 5. The AD admin must grant full mailbox access permissions to the resource account's mailbox.          
 l Exchange 2003—Using AD Users and Computers, open the Properties for the resource account. Under 

the Exchange Advanced tab, click the Mailbox Rights button, Click Add and specify the TMS-service 
account. While the TMS-Service account is selected, mark the checkbox for allow full mailbox access. 
Click OK and OK again to close the properties for the resource account

 l Exchange 2007 – Use the Exchange Management Shell to grant the full mailbox access on the 
resource account to the TMS-Service account. An example is shown below, replace the Resource and 
User accounts names as necessary
Add-MailboxPermission -Identity domain\ResourceName 
–User domain\TMS-Service -AccessRights FullAccess –InheritanceType All

 6. The AD admin must configure essential Calendar Settings for the account.         
 l Exchange 2003: This step will be completed using the configuration tool and can be skipped here
 l Exchange 2007: Use the Exchange Management Shell to change the MailboxCalendarSetting 

AutomateProcessing to AutoAccept and disable the default settings that change the conference title. 
An example is shown below, replace the resource account name as necessary
Set-MailboxCalendarSettings –Identity domain\ResourceName 
–AutomateProcessing:Autoaccept –DeleteSubject $false 
–AddOrganizerToSubject $false

Running the software installer
The standard Cisco TMSXE software installer can now be run taking note of the below points. For a more 
detailed description of the software installer's steps, see the Installing the software [p.12] section.
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 n The Exchange admin user should be the user to run the installer
 n When specifying the Exchange service user, the installer will automatically detect the pre-staged TMS-

Service user account:
 a. Accept to use this account.
 b. When prompted for the Exchange service user password, select  I have the password and will provide 

it below.
 c. Enter the password set during pre-installation.

 n When prompted for the Cisco TMS service user account:
 a. Select  I have created a service user on the TMS server.
 b. Enter the credentials of the tmsconfuser account set up during pre-installation.

Enabling the resource accounts
After the server software has been installed, the Exchange admin can use the configuration tool to enable the 
accounts that were previously staged by the AD admin. These steps can be repeated any time new resource 
accounts have been staged for addition to Cisco TMSXE.

 1. Start the configuration tool  as the Exchange admin. The tool is available under  Programs > TANDBERG 
> TANDBERG Conferencing eXtensions for Microsoft Exchange > TANDBERG Configuration

 2. The self-test during start-up of the configuration tool will detect errors with any accounts that have been 
pre-staged. When prompted whether you wish to repair them, click Yes. The configuration tool will set up 
the sinks automatically for you.

 3. If users are to be granted permissions to the resource calendars, the AD admin should have specified 
these groups during the pre-installation steps. Switch to Resource Defaults, and ensure the groups are 
set in the Resource Calendar Permissions section. If not, use the Browse button to select the existing 
group for each setting. Switch back to the Operations tab when complete to continue.

 4. The accounts that were pre-staged will appear in the right hand column as if they were already enabled. 
Use the actions available in the configuration tool to complete the setup of the accounts.

 5. Highlight the accounts that have been pre-staged. Use Shift or Control to select multiple systems. 
Right-click the highlighted systems and select Add Calendar Permissions. A pop-up window will appear 
showing the progress of the work. Click OK when complete.

 6. Repeat the previous step for each of the following actions:
 a. Enable Autobooking. This is not available in the Configuration tool when installed on Exchange 2007 

servers. The setting is only needed if doing Direct Resource Booking.
 b. (Re-)Book all Meetings

The pre-staged accounts are now properly integrated with Cisco TMSXE.

Completing the installation
When the initial resource accounts have been fully enabled using the configuration tool, the remainder of the 
installation should be completed using the standard installation instructions:

 n Enabling Cisco TMS systems in Exchange [p.15]: Must be completed by the Exchange admin.
 n Tuning security settings  [p.22]: Must be completed by the AD admin and Exchange admin.
 n Deploying the Cisco form [p.23]: Optional step to be completed by the Exchange admin.

Cisco TMSXE Installation Guide (2.3) Page 40 of 44

Appendix 3. Installing and using Cisco TMSXE with separate administrator roles



Upgrading
When performing an upgrade, the existing accounts remain intact, and no staging or pre-installation steps are 
required by the AD admin. The setup file can be run by the Exchange admin following the standard 
instructions.

If the previous software version was uninstalled before upgrading, the existing resource accounts were 
disabled for integration during the uninstall. However, this will be detected by the configuration tool when  run 
by the administrator after the upgrade has completed. You will be prompt whether you wish to repair them—
click Yes to re-enable the accounts.

Uninstalling Cisco TMSXE
The product can be uninstalled by the Exchange admin using the standard methods. Optionally, if the 
resource and service accounts will not be needed for future use, the AD admin can safely remove the 
accounts completely. See Uninstalling or repairing the installation [p.31] for more details.

Operational differences
When using separate Exchange and Active Directory administrators, not all features of the Configuration tool 
will function because you may lack the permissions necessary. The tool will report an error if you do not have 
sufficient permissions to complete the task.

Note: A complete description of the configuration tool and its options can be found in the Cisco TMSXE 
Administrator Guide (2.3.1); this section only highlights what to be aware of when administrator roles are 
separated.

Operations tab

The following action commands will not complete without AD admin rights:

 n Add Service User Permissions
 n Reconfigure Account(s) from TMS
 n Remove AD User(s)
 n Detach from Integration

Removing/disabling accounts

Without full permissions, accounts cannot be removed automatically using the configuration tool. 

To remove an account from Cisco TMSXE without removing it from Exchange, do the following:

 1. Using the configuration tool, have the Exchange admin use the Disable Sinks action in the Operations 
tab

 2. Using AD Users and Computers, have the AD admin remove the following from the resource account         
 a. the extensionAttribute1 value
 b. the send as and receive as permissions granted to the TMS-Service account
 c. the full mailbox access permission granted to the TMS-Service Account

To remove an account from both Cisco TMSXE and Exchange, have the AD admin delete both the user 
account and mailbox.
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Configuration tab 
Using the Change the Password for Service User functionality requires AD admin permissions.

All other settings may be configured by the Exchange admin.

Resource Defaults tab 
All settings may be changed by the Exchange admin.
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